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Dear Children, 
Today it is modern technology that leads us in the path of our prog-

ress. Information and Communications Technology has radically 
changed the modern world. It has influenced every sphere of our life. 
It is utilised by homes, hospitals, shops, schools and even space  
stations. It has become an absolute necessity to know this technolgy 
in detail for any facility in life is to be gainful. This activitybook is  
designed to equip you to use the computer and the Internet to achieve 
that end.   

The activities in this book are included for that purpose. They aim 
not only at drawing pictures, designing book covers and pages,  
analysing data, and presenting ideas but also at learning through  
computers maths, science and languages. 

At the same time, you also get a chance to be familiar with areas 
like Computer Programming and Artificial Intelligence (AI). Also, 
you get to discuss the safe use of the Internet and addressing fake 
news.

The more you enjoy these activities, the more interesting your 
learning will be. You may also be able to utilize these lessons to  
understand further about the IT sector and to profitably learn other 
subjects. 

I wish you very well.
Dr Jayaprakash R. K.

Director, S.C.E.R.T. 

PREFACE
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Chapter 1

Information Analysis

Anu, Ami, Sainu and Vinu are all involved in a 
serious discussion on finishing the science project 
assigned by their teacher, Mary. The project is about 
finding the areas of forests in Kerala as per each 
district over two different years.  As part of doing 
this project, they have to gather necessary  
information, analyse it and reach a conclusion before 
presenting to their class in an easy-to-understand 
manner. For this, they checked library books, peri-
odicals, Internet and project reports prepared by the 
students in previous years.
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What the Graphs have to say

It was Ami who spotted the graphs shown 
below in a magazine and brought it to the 
notice of the project team. See how neat the 
info presented in the graphs is!

Please make a note of what the graphs have to say. 

• The average estimate of the rain received by 5 dis-
tricts of Kerala in the first week of October, 2023.

• The districts that received the highest and lowest 
rainfall.

• The estimate of rain received by other districts.

• --------------------------------------------------

Graphs makes analysis of info easy and fast, don’t 
they? We can also draw graphs like these, can’t we? 
Why can’t we include such an activity in our projects?  

The teacher had given Anu and her team several hints 
about the topics for the project. The team selected the 
topic, “A Comparative Study of Kerala’s Forest Areas 
per District” as it was a socially relevant one. 

The study needs the statistics of forest areas for two 
years. Do you have any idea where you can get such 
statistics? 

Fig 1. 1 Rainfall in some districts of Kerala in October, 2023

Study Projects 
in Computer

All learning projects go 
through a few steps: Info-
gathering, analysis, 
consolidation and conclu-
sions. Computers have made 
these steps easier. The soft-
ware for the same is included 
in our school computers.
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Gayatri, one of the team members, had a suggestion: 
Why don’t we search it in the Internet?

So the team used the Internet to find the forest 
area in each district for the years 2011 and 2021. 
They promptly recorded it in their Project Diary. 
See Table 1.1. 

Using the data in the table, let’s see what we can do. 
Don’t forget to take down notes about what we find. 

• An estimate of the total forest area in the two years. 

• The average forest area in the State in those two 
years.

• The districts that have the largest and the smallest 
forest area.

• The changes in the State’s forest cover over ten 
years.

•  --------------------------------------------------------

Table 1.1. Kerala’s district-wise forest area 
for the years 2011 and 2021
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LibreOffice Calc
Once you open the LibreOffice Calc, you see a worksheet of columns and rows 
(See the picture).
Columns are labelled A, B, C … and rows 1, 2, 3 … 
The squares you fill in with data are called cells. A cell 
is denoted by the letter of its column and the number 
of its row. The cells in column A will be called A1, A2, 
A3 and so on. The cells in row 1 will be called A1, B1, 
C1 and so on. 

Spreadsheet Software
The software that enables us to arrange and analyse data is called spreadsheets. Some 
of its facilities are given below:
    • Tabulating data.
    • Arranging the tabulated data in different formats.
    • Enabling the analysis, comparison and consolidation of the data.
    • Arranging the data in graphic forms (charts) to make analysis easier. 
Today, many spreadsheet software programmes are available. The spreadsheet software 
included in IT@School GNU-Linux is LibreOffice Calc. There are also programmes 
like Microsoft Excel, Gnumeric, Calligra Sheets and Numbers.

Cell Address

Now, we have to analyse the data in the Table 1.1. 
Can we use our computer for that? You have seen that 
the graphs shown by Ami were prepared by a computer. 
Computers and their software are therefore making our 
tasks easier, aren’t they? 

The team decided to use their computer to analyse the 
info for their project. They already knew that their 
seniors had used spreadsheet software for data analysis. 

Let’s have a look at the various phases of the project 
Anu and her team had gone through.

So the team made up their mind to use the spreadsheet 
called LibreOffice Calc in the Lab computers for ana-
lysing their data.
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Fig. 1.2. The districts and the forest area typed into the Calc sheet

Recording Data in Calc

First, the team put the Internet data they collected in 
the Calc sheet. See Fig1.2.

The first column shows the names of districts, the 
second their forest area in 2011 and the third their 
forest area in 2021. 

•	 When you type in the numbers where are they  
positioned in the cell?

•	 Where in the cell do the texts appear?

•	  Can we change the position of the texts and num-
bers? Try and see.  

You can also change the size of a cell as required. 

To Type in Data in the
 Spreadsheet

•	 Click the mouse in the cell 
you need.

•	 Type in data with the key-
board.

•	 Name the file appropriately 
and save it.
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The change in the formula bar
when the tool to find the sum 
was activated

Functions 
in the Calc

Sum is a function in the 
LibreOffice Calc. There are
many functions like 
Average and Count in the 
Calc.
You will learn those in higher
classes.

Finding the ‘Sum’ in the Cells
• Click in the cell where you want to display the sum (cell B16 in this case).
• Click on the symbol ∑ left to the cell address (When you click, the cells 

with numbers in that column will be selected). 
• Press the Enter key to get the sum in the cell into which you typed.
• Save the file after those changes. 

Fig. 1. 3. The method to find the sum of the numbers in 
the Calc sheet, using the SUM tool

You have now tabulated the forest land in each 
district. The next step is to find out the total forest 
cover, using the software. 

To Change the Size of Columns and Rows

Sometimes you will have to change the width of the columns and the height 
of the rows. Click on the point where the header of 
the column you want to change and the next column’s 
header join. When the arrow marks appear drag them 
to get the size you want. In the same way, you can also 
change the size of the rows. Try it.

The cell for displaying the sum
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Putting the Function 
straight into the cell

We need not use the tool  
∑ to get the sum of 
numbers. 
You can type directly into 
the cell where you want 
to display it. E.g. = SUM 
(B2:B15)
B2: B15 in the function 
means the cells from B2 
to B15. 

Finding the Total Forest Area

One of the important special features of the 
spreadsheet software is the tools that help us to do 
mathematical calculations. For instance, suppose we 
have to calculate the total forest area in Kerala. To 
find it out, we can use the tool for finding the sum 
in the spreadsheet. Fig.1.3. shows the method to find 
the total forest area. You can also try it on your own. 

Have you found the total forest area in 2011. 
Now, find the forest area in 2021 in the same way.

•	 To do the sum, which cell in the spreadsheet 
(shown in Fig.1.3.) must be first selected?

      ---------------------------------------------------

•	 What gets displayed on the formula bar when 
you have found the sum?

      -----------------------------------------------------

Arranging the Districts on the Basis of Forest 
Cover

Shall we arrange the districts in terms of their 
forest area? Let’s do it in the descending order with 
the district with the largest area on top and the district 
with the smallest area at the bottom. The tool we 
need is Sort in the Data menu. Fig. 1. 4. shows the 
arrangement in Sort window  to list the districts as 
per their forest area in 2021. 

Here, the list of districts as per forest area in 2021 
is displayed because we selected Forest Area 2011 
(in sq. km) for the box of Sort Key 1. 

Suppose you want to get the list of districts as per 
forest area in 2011; which column will you select 
for Sort Key 1?



Information Analysis14

INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Fig. 1.4. The Sort window of the LibreOffice Calc

Sorting the Lables in Calc Sheet
• Select the table to be sorted. (To do so, click on the first cell; press the ‘shift’ 

key and click on the last cell to be selected). 
• Click on Data on the Menu bar and select Sort. 
• Select the header of the column you want to sort to put it in Sort Key 1 (In this 

case, Forest Area 2021 (in sq.km). 
• Select Descending from Ascending/Descending options against Sort Key 1
• Press ‘OK’ 

How will you sort the districts with the one having 
smallest forest area on top? 

Graphs for Comparative Study

We can use graphs and charts for the easy 
comparison of data. Maybe, you still remember how 
graphs enabled us to easily compare data previously.
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To Select the Necessary Parts from the Table
•	 Click on the first cell to be selected (Here, A1).
•	 Press and hold Shift and click on the last cell 

to be selected (Here C15)
•	 There are other ways to do this. Hope you’ll 

find them out.

Fig. 1. 5. The selected portion from the table for the graph

Shall we prepare a graph using the data in the 
Calc sheet?

First, we have to select those items in the table 
that we need for drawing a graph. Fig.1.5. shows the 
selected portion in the sheet. Please have a look at it. 

You can see that the row for the Total Forest Area 
is not selected. What do you think may be the reason? 
Try to guess, please. Write it down the exact reason 
in your notebook after finishing the graph.

Once you have selected the portion for the graph, 
we have to use tool to determine the type of chart 
we need. The tool is the Chart option in the Insert 
menu of the Calc sheet. Once you select the tool, a 
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new widow will be displayed. See Fig. 1. 6

• On the left of the window, you can see Chart 
Type selected. There are also other options like 
Data Range and Data Series; those you will 
learn in higher classes.

• Go to Choose a Chart Type; you can see 
Column selected. 

• Since we are not using options like Data range, 
we can now click Finish. 

Fig. 1.7. shows the graph we obtain, once you finish 
the task.

Fig. 1.7. The Graph Prepared

Fig. 1.6. The Chart Type Wizard

District

Don't forget to 
save the file.
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Examine the graph to answer the following questions:

• Which are the districts without any change in 
their forest land? 

• Why did the name of the districts appear in the 
chart? 

• What change would be there in the chart, if we 
selected the row Total Forest Area also at the 
time of preparing the chart.

• What will be the changes if we omit the headers, 
‘District’, ‘Forest Area 2011 (in sq.km.)’ and 
‘Forest Area 2021 (in sq. km)’ when we prepare 
the chart?  

Table 1.2. shows the activities we did to draw the 
chart. Arrange those activities in the order we did it 
with the first step coming first.

             Assessment

    • The name of the spreadsheet software in LibreOffice 

      a. Writer                                       b. Impress

      c. Calc                                          d. Calligra Sheets

    • What is the aim of Sort Ascending option in LibreOffice Calc?

    a. To arrange data in ascending order     b. To arrange data in descending order

    c. To shuffle data randomly                    d. To erase the selected data

Table 1.2. The Steps to Build a Chart in the LibreOffice Calc

Step 1    Select Chart Type and other options from the window obtained

Step 2    Select only the portion necessary for making the chart

Step 3     Click on the Finish button 

Step 4   Select Chart option from the Insert menu

             Assessment
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   • To calculate the ----- of the numbers in cells A1 to A5, we can use = SUM(A1:A5).

          Follow-up

1. Collect the number of students coming to school by various modes of transporta-
tion and tabulate it in LibreOffice Calc as shown below. Find out the transportation 
most students use, using the appropriate tool in Calc.

2. Below is shown the score secured by some students in first terminal exams. 
Calculate the total score of each student using LibreOffice Calc.

3.Complete the table after collecting data from your classmates. Using the appro-
priate tools in Calc, compare the data in the table.

Sl.No   Name   Malayalam     English    Hindi      Social     Science      Maths
 1        Anu         88             90            85           70           75              68
 2        Aami        85               80           82          79           78              80
 3        Vinu            78                80             81          83           80              79
 4        Sainu           57                55             60          75           90              92
 5        Joshy           65                70             60          78           88              89

  

Mode of Conveyance     Cycle   School Bus   On Foot     Public Transport System   Own Vehicle

Number of Students  

          Follow-up

Class   Those residing 
within 1 km. of 

the school

Those residing 
within 2 kms. of 

the school 

Others

4. Find and list the activities around you that can be analysed using spreadsheet 
techniques familiar to you. 

• ...................................................................................................................................

• ..................................................................................................................................
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Chapter 2

Let’s Search and Find

Take a look at the picture above. 

It’s a picture Ammu secured for her Photo Album 
about Kerala’s art forms. 

Could you help Ammu to write a description for her 
photo to add in her Album?

First, we have to find out which form of art it is.
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Server and Web Browser
A web page is a document or page on the Internet with its own address. 
A web server is a powerful computer that stores web pages, web server 
software and other supporting utilities. 

Browser
‘Browser’ is the software that needed in the user's system to see the web 
pages stored in the server.

How do we find it out?

• We can browse through books or magazines on Ker-
ala’s art forms.

• We can search the Internet.

•  --------------------------------------

Which one of the above is the easiest source for search?

Internet facility is widespread today. If one has a computer 
or a smartphone, one can get data as and when one needs. 
Indeed, one has always ample data on one’s fingertips.

Internet – A Place for Data-Search

How do we get data from the Internet? 

What facilities do our computers need for searching? 

• We have to connect our system to the Internet (This 
can be done with a cable or a wireless device). 

• Our system needs a software called web browser to 
display the data from the server (the master computer 
in which data are stored). 

It is very hard, as you know, to dig up the data we want 
from the huge collection of data in the Internet. But there 
are many websites in the Internet itself that can help us 

            Internet
The Internet is the global 
system of interconnected 
computers and computer 
networks located around 
the world to communicate 
between networks and 
devices in order to perform
a variety of services. 

            Internet
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Category: 

Name:

Table 2. 1. Search Engines and Web Browsers

Category: 
Name: Chrome

Category:

Name

Category: Search Engine
Name:

in this regard. They are called ‘search engines’.

Differentiate between web browsers and search 
engines in the picture given below. 

Let's search the name of the Kerala art form de-
picted in the picture Ammu has. 

    • Go to Home and locate School_Resources. 

You can see the picture in the the folder for Class 
VII students.  

How do we collect from the Internet the informa-
tion about this picture? 
•	 Open a search engine that can help us to upload 

the picture. 
•	 Click on the icon, Search by image
The window that opens will display Upload a file. 

I’ve so far searched 
information only by 
typing words in the 
search box

Can we also use 
images to search?
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Fig. 2.1. The Search Engine window

Fig. 2.2. Search results

• Upload the picture in the window See Fig.2. 1.

What have you got? Yes; so many pictures similar 
to the one we uploaded. See Fig. 2.2.

Click on those pictures to get the name of the art 
form we’re looking for. 

What is its name? Yes, Chavittunadakam (A Play 
of Foot Taps), a form of folk theatre. 

The kind of search we have now done is called 
reverse image searching. 

Now, find out more details about this art form of 
Kerala. 
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Fig. 2.3. The Web Search Window

Let’s Find the Details

To find the details about Chavittunadakam, you 
need to type in your browser’s search box appropriate 
words/phrases related to that art form. Those words 
are generally called key words. 

Can you guess the key words to be typed into 
the search box to get details of Chavittunadakam in 
Malayalam? Write them down after you discuss it 
with your classmates. 

    • Chavittunadakam in Malayalam.

    • Chavittunadakam history in Malayalam.

    • ------------------------------------------- 

Fig.2.3. shows the list of websites obtained when 
Chavittunadakam in Malayalam was typed in the 
search box. 

Reverse Image Search
Reverse Image Searching is a special feature in search engine that helps 

us locate the webpage we want from billions of web pages. Almost all 
search engines have this system. We don’t need to type in words in this 
system; we just have to upload the picture we have to get other similar 
images and related data.  
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   Search Engines and Artificial Intelligence (AI)

When you started to type in Chavittunadakam in the search box, you may 
have noticed the web page automatically display other hints related to it (e.g., 
Chavittunadakam in Malayalam, Chavittunadakam songs, Chavittunadakam 
history).  It is as though the system knew our search intentions! How does this 
happen? 

It is with the help of Artificial Intelligence (AI) that the search engines figure 
out our search intentions. The search engines collect all the data of searches 
that happen all over the world (including our search data). They then analyse 
these billions of bits of info with the help of AI. That means, the search engines 
already know what people anywhere in the world are usually going to search! 
When we start searching, they give us hints based on those previous searches. 

Haven’t you got enough data to write even an article 
about Chavittunadakam?  You can now make a note of 
the necessary details from the web pages. Alternately, 
you can copy them into your LibreOffice Writer and 
save them in a folder. 

Search Filters

Look carefully at the browser window in Fig. 2. 4. 

What tabs do you see below the search box? 

• All

• Videos

•  --------

•  --------

Fig. 2.4. The Tabs in Web Browser Window

   Search Engines and Artificial Intelligence (AI)
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Tab Use
Size
Color
Type 
Time 
Usage Rights 

Table 2.2. Search Filters

        Copyright

We cannot download and use free all the resources in the Internet. Some of 
them are protected by copyright. We have to check that before we download. 
If you click on the tab, Usage Rights, you can see if a picture is copyrighted. 

The tab, Usage Rigths has the option called Creative Common licences. We 
can use free the pictures in that category. If we want to use pictures in other 
categories, we have to obey their conditions.

Which tab would you use to get more pictures 
about Chavittunadakam?

Which tab is to be used to get videos about it? 
Check each tab and find out. 

Click on the tab, Tools in the search window. You 
can see new tabs like Size, Color, Type, Time and 
Usage Rights popping up. Check those tabs and find 
out their uses to complete the table below. 

        Copyright
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I didn’t go to school 
yesterday as I saw in 

the Internet that it was a 
holiday. Only today did  

I realise that the  
news was fake. 

Our teacher has told us
 to ensure that the news of 
holiday is true by checking 

official websites.

Internet in Day-to-Day Life
You have now learned to get texts, images and 

videos from the Internet in an instant. 
What are the other uses of the Internet? Can you 

make a list?

•	 Get News. Read online newspapers. Watch TV 
channels.

•	 Share messages through social media.

•	 Buys things online. Book movie tickets.

•	  Pay utility bills.

•	  -------------------------- 

•	  -------------------------- 

In general, the Internet has become a part of our 
daily life. It has penetrated into almost all areas of 
our life. But, caution! Do NOT trust blindly every 
bit of info you get from the Internet. Some websites 
may contain misinformation. 
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Web Mapping or Online Mapping is the 
platform that can prepare a region’s map 
using the Internet and satellite technol-
ogy. Such platforms display not only a 
region’s map but also the region’s sat-
ellite images, distances between places 
and their routes. Some platforms inform 
us about the routes with less traffic. Such 
platforms are also of great help in train 
travels when we want to locate stations 
and times of arrival and departure. 

Internet as a Guide

Earlier, travellers and sailors were guided by
observing the position of the Sun and the stars. Today, a 
smartphone connected to the Internet can act as a 
travel-guide. Maybe, you have seen online maps for 
distant travels. What are those maps? Can you guess 
them to complete the list below. 

• Open Street Map

• Bing Maps

• .........................

• .........................

How do these help us in our journey. Just make a 
list of facilities these maps provide. 

• We can share our location.

• We can find the distance to the location.

•  We can find the time for travel. 

• ....................................................

Web Mapping



INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Let’s Search and Find28

Cyber World
We have discovered that we can instantly find a lot 

of info about diverse topics from the Internet. That 
means, the Internet is a wide world of information. 
This virtual world of data is usually called the cyber 
world. 

If you share and spread on the net information that 
defame individuals and institutions, it is considered 
a crime. The crime perpetrated by means of modern 
communication technologies like mobile phones and 
computers is called cybercrime.  Almost every country 
has laws to deal with such crimes and the culprits. 
The control of and punishment for cybercrime in 
India falls under the laws of Indian IT Act. 

                      Global Positiong System (GPS)
How do these maps on devices like smartphones show us the route to our 

destination? Have you ever thought about it? How do they inform us exactly 
about how far we need to travel or at what point we have to take a turn?  

The system that enables these facilities is called the Global Positioning 
System (GPS). It is a satellite based system that can determine exactly our 
position on the Earth. GPS functions with the help of the satellites deployed 
around the Earth. They are deployed in a such a way that three or four 
satellites can survey at the same time any place on the Earth.   

                      Global Positiong System (GPS)
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           Assessment
    • Which of the following is a browser?
  a. Yahoo!                            b. Google
  c. Bing   d. Firefox

    • Which of the following is an example of online map? 
   a. Mozilla Firefox   b. Open Street Map
  c. DuckDuckGo  d. Google Chrome

    • Which of the following is a satellite device that can determine the destination 
and the direction of a traveller? 
  a. GPS    b. Search Engine
  c. Web Browser   d. Google Chrome

          Follow-up
   
1. Get the pictures of Indian freedom fighters with Creative Commons Licence, 

from the Internet and save them in a folder. 

2. Collect data from the Internet to present a paper on The Safe Use of the Internet
in a seminar conducted by your IT Club

           

          Follow-up
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Chapter 3

A Magazine on the Computer

The editorial board is delighted to have received 
articles to be published in its school magazine. More 
students have participated this time around. The board 
would like to turn the articles into a digital magazine 
and upload it to the School Wiki.   

As part of the project, the board examined the digital 
magazines in the School Wiki. Fig. 3.1. shows the two 
pages they prepared after their research. The pages 
contain a story and an article on precautions for using 
social media. 
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What all are included in these pages? 

    • Arrangements of the text.

    • Various shapes have been added.

    • Background colours has been given.

    • -------------------------

Let’s learn how such similar pages can be made using 
LibreOffice Writer. 

Let’s Make Our Content Nice

 We already know how to type our content and its 
title in LibreOffice Writer. You have also learned how 
to beautify the content typed using LibreOffice Writer.

Open LibreOffice Writer and type in the following 
content. Also, make it attractive by using the tools 
you have mastered. 

Fig. 3. 1. Digital Magazine pages – models. 
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Other than typing in, what are the ways by which 
we can enter content in a document? Hope you’ll 
discuss this with your classmates. 

Various Ways of Entering Texts
We already know how to type in content using the keyboard. 
But there are also many other ways of entering texts in a document. 
•	 Speech Recognition: We can turn data in audio form into texts with the help 

of a special software. 
•	 Optical Character Reading (OCR): With the help of a software, we can turn 

pages into images (We can either scan these pages or take a snap of them with 
our mobile) and convert it into texts. The ‘gImage Reader’ in our system is a 
software that can help us in this task. 

•	 Pointing Tools: The Onboard Application in our system is such a tool. With 
its help, we can enter texts by clicking on the screen. 

Ammu’s Delight 
Haven’t you seen the butterflies that come to sip honey in the garden full of 
flowers? 
How beautiful they are! Each butterfly has different colours. Ammu also likes 
to watch them flap their little wings and fly away. 
Ammu used to go to school every morning by caressing the flowers in the 
garden and saying goodbye to the butterflies. But today, not a single butterfly 
is seen! Ammu was sad. 
“They will come after a while, take a quick shower and go to school,” said 
mother. 
Ammu went to school feeling sad that day. After returning from school and 
without even changing her uniform, she ran to the garden. It seems that be-
cause the butterflies didn’t come, the flowers were withered and tired. Ammu 
went to bed early that day. When Ammu woke up the next morning, she ran 
to the garden. Ammu was happy to see the butterflies flying from flower to 
flower... 
“Where were you yesterday?” Smiling butterflies flew around Ammu. Ammu 
felt as if she had turned into a flower with happiness. 
Nada C. 
Class: 7C
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The table below shows some of the tools in the 
Writer software you have mastered. Which of the 
following tools have you while typing? Complete the 
table by entering all the tools you used while typing 
the content above.

Entering Shapes

Our pages may contain titles and words/phrases 
to be emphasised. In the document we have typed, 
they must look different from the other words in the 
text. You must have already noticed the titles in the 
sample given. Look at Fig. 3. 2. to examine their 
special features. 

•	 The titles are encased in special shapes

•	 The shapes are given colours. 

•	 .................................................

•	 .................................................

Font Size To change the letter-size

Font Name ..............................

Italics ..............................

Underline To underline letters

Font Color ..............................

Fig. 3. 2. Arrangement of Titles

Table 3. 1. Some Formatting Tool in LibreOffice Writer
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How do we prepare documents that include such 
kind of  shapes? Let’s see. 

LibreOffice Writer has several shapes in its Tool 
bar. We can select from them the shapes we want to 
include in our document. We can also change their 
size.  

Enter the shapes (as shown in the sample given) 
in the document you have typed. And don’t forget to 
note down how you have entered the shapes. 

You can as well type your content into the shapes 
you have just included. Try it, please. 

Entering Shapes in the Page
•	 Select appropriate shapes from the Toolbar.
•	 Click on the spot in the page where you need 

the shape and drag the mouse.

Changing the Size of the Shape
•	 Click on the shape to be changed.
•	 Click on the squares around it and drag them.

If you don’t see 
the Drawing Toolbar,

tick against  
View→ Toolbars→ Drawing

Double click
 on the shape 

to type in the text 

AI generated image
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When you add shapes or images, the text in that 
part may get shifted or overlapped. LibreOffice Writer 
also has ways to overcome this problem. The tool 
wrap is meant for solving it. If you click the right 
button of the mouse on the shape/image, the tool, 
wrap will pop up. 

Just drag the shape you have just entered towards 
the text. What do you see? Now, try the options in 
the wrap tool and complete the table 3.2. 

Adding Pictures to the Text
Sometimes we need to include pictures in our 

document. To do this, you have to go to Insert menu 
in the LibreOffice Writer and select the option, Image. 

When you include pictures, you may face some 
issues.
•	 You may have to crop the picture according to 

the space available
•	 You may have to use only a part of the picture
•	 You may have to rotate the picture
•	 ...........................................

Inserting Pictures  
in the  Document

•	 Click on the spot where 
you want the picture

•	 Select Image from the 
Insert menu

•	 Select the picture from 
the window and click 
Open’

Wrap Off

Text can be arranged above and below the shape. 
In this setting, text will not appear on either side 
of the image.

Optimal Wrap Text gets adjusted as the shape moves.

Wrap Through ......................

Wrap before To arrange the text on the left side of the shape.

Wrap after ..............................

Table 3.2 Shape / Image wrap features
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The sign that pops 
up when the picture 

is chosen

The sign that pops 
up when the Crop

tool is selected

You can change the size of pictures in the same way 
as you have changed the size of shapes. 

Try it in the document you are preparing; use the ‘crop’ 
tool as well if you need. 

To cut a portion from the picture, you have to use 
image editing software you have used earlier. 

Cropping Pictures
• Right click on the picture
• Select Crop from the menu
• The sign to change size will shift to the sign for 

cropping 
• Click on the sign and drag to eliminate the unwanted 

parts of the picture 

Fig 3. 3. The changes at the borders as you select the picture or 
use the option, Crop, the signs 
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Hope you will make appropriate changes in the 
pictures you have entered. 

When you selected your picture, you might have 
noticed some new tools appear. See Table3.3.

You already know that the first tool is for cropping. 
What are the uses of other tools? Select the image 
you just inserted and identify the use of these tools. 
Then complete the table. 

Adding More Style to the Page

We have included in the pages text, images and 
shapes. What else is there in the sample (Fig.3.1) 
given to make the page more appealing?

•	 The whole page has been coloured.

•	 The page has been given border.  

Go to the Format menu in the Writer and click on 
Page Style to see what pops up in the window. There 
are tabs which help us to colour and border the page. 
Use them to change the document’s style. 

We change the background colour of the shapes 
in our document in the same way. Right click on the 

Tool Use
to crop

to flip

.......  ............

to rotate left

........  ............

.........  ............

Table 3.3.  Tools appear while selecting image
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shape and select Area from the menu. Use the options 
there to see what changes you can make.

Save your changes as you make them.   

Using the tools you have learned by now, you can 
make your document as attractive as practicable. There 
are many other facilities in LibreOffice Writer. You 
will learn them in higher classes.

       Assessment

    • Which of the following is a LibreOffice Writer file?

    a. Magazine.ggb

    b. Magazine.odt

    c. Magazine.mp4

    d. Magazine.mp3

• Which is the LibreOffice writer Toolbar that carries the tools to draw geo metric 
shapes including the geometric ones? 

    a. Standard

    b. Drawing

    c. Formatting

    d. Table

    • When you add a picture in your document, the text in that place may get 
displaced. Which tool would you use to solve this problem? 
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       Follow-up

1. The illustrated description of your school excursion needs to be published in 
your school magazine. Prepare the description using LibreOffice Writer.

2. Using LibreOffice Writer, prepare a poster to displays the precautions on cyber 
securaty. 

3. Using the Drawing Toolbar in LibreOffice Writer, draw the picture given below. 

       Follow-up
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Chapter 4

Colourful Pictures

Ravi was checking his friends’ articles for the school 
magazine, when he spotted Hita’s travelogue. 

The teacher has told the editorial team to make a digital 
magazine this time around. They already know how to 
type the text using computer. But how do they include 
Hita’s hand drawn picture in the computer? 

There are a few possible ways given below. Have a 
look at them, please.

Wow! The  
lighthouse we’ve 

climbed up. Was it 
drawn on the  
computer? 

Look at the  
travelogue Hita 

 has written!
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• We can take a snap of the picture using camera 
and copy it onto the computer. 

• We can include the picture in a computer with 
the help of a scanner. 

Besides, we can directly draw or paint the picture 
on the computer. 

If we draw the picture on the computer, we can 
make it sharper and clearer, don’t you think? Not 
only Hita’s picture but also the pictures for other 
articles too can be drawn thus to make the magazine 
more attractive. 

 How do we draw Hita’s picture on our computer? 
Shall we give it a go? 

You know, we need a painting software to draw 
digital pictures. Our computer has more than one such 
software. You have already learned some of them in 
previous classes. Which are they?

    • Tux Paint

    • ------------ 

Our computer has a software called Krita for 
drawing and painting. It is one of the best painting 
software with many facilities. Let's do this activity 
using Krita.

Krita is a free graphic software for painting and 
animation. Krita can also help us to create pictures, 
posters, brochures and ads, and to edit them.

Krita
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Look at Fig. 4.1. It is a sample of the picture in Hita’s 
travelogue. We need to create such a picture on our 
computer. 

Hita has painted a seashore in daytime. What are the 
things you see in the picture? 

    • The sky dotted with little clouds

    • The sea

    • The shore

    •........................

One by one, let’s draw these things in the list with the 
Krita software. 

Let’s Get the Canvas Ready

First, we need a canvas to draw. And, we have to 
determine the size of the canvas. Let’s say we need a 
canvas with a width for 800 pixels and a height for 500 
pixels. Now, open Krita to create a canvas of that size. 

In digital imaging, pixel 
is the smallest addressable 
element in an image. The 
word pixel is a combina-
tion of pix (from pictures, 
shortened to pics) and el 
(for element). The size of 
an image is depended by 
how many pixels make up 
an image.

Pixel

Fig. 4.1. The sample picture to be created on the computer



INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Colourful Pictures 43

Once the canvas is ready, you can draw the picture 
on it. 
 Let's Familiarise Krita 

Look at Fig.4.2. What you see is the main window 
of Krita.

•  Open Krita and click on New File.
• Specify in the window the required width and 

height of the canvas.

• Click on Create at the bottom of the window

Creating Canvas in Krita

Fig. 4.2. Krita’s Main Window
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You now know the important features of Krita. 
Let’s now go to the left of the window. Touch the 
mouse pointer on each tool in the toolbox. What do 
you see?  You see the names of each tool popping 
up, don’t you? Complete the table below using the 
names of these tools. 

Dockers are small sub-
windows found in Krita 
software. It contains useful tools 
like color selector, layer stack 
etc.

Krita Docker window

Layers are an important feature in image 
editing software. Layers are transparent 
skins that can be added on top of an image. 

It will be convenient for editing later if 
each part of the image is drawn in different 

layers. See the 
tool for adding 
a new Layer. It 
is marked in the 
image.

Dockers Layers

Table 4.1. Some tools in Krita

Freehand brush tool

Layer Window in Krita
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Since we have learned about the dockers and tools 
in Krita, let’s start drawing the picture that Hita 
painted. 
Let’s Draw the Sky

We’ve already seen that parts of images can be 
drawn in different layers. This facility is also avail-
able in Krita. 

As we open the canvas in Krita, you can see two 
layers appear – Background layer & Layer Paint 1. 
To draw the picture, we need to select these two layers 
from the Layers Docker.

In our picture, the background has the sea, the sky 
and the seashore. Other things are drawn as objects. 
Look at Fig. 4.3 and complete the table 4.2. by finding 
the appropriate layer for each picture.

Look at how colour is applied to the sky as in 
Fig.4.4. The sky is drawn using two colours – blue 
on the top and white at the bottom. When you want 
to add two colours in this fashion, you can use the 
tool, Gradient (G) in Krita. 

Fig. 4.3. Krita’s Layer window

Table 4.2. Layers for Painting

Background  Background
Lighthouse

Grass

When you select
the ‘Background layer’, 

please don’t forget to 
remove the ‘Lock’.



INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Colourful Pictures46

See fig. 4.4. Try painting the sky in your canvas 
as shown in the figure.

The sky is drawn. Now, shall we add the sea?

Let's Drawn the Sea

You have to add the sea at the bottom half of the 
canvas. There are various tools in Krita to select a 
particular portion of the canvas. To get a rectangular 
shape, you can use Rectangular Selection tool. To 
paint that part, use Gradient tool. 

Now, using the Gradient tool, apply the colour of 
the sea at the bottom-half the canvas.  See fig. 4.5.

We have now the sea and the sky in the background. 
Let’s proceed to add the seashore in the same layer. 

Fig. 4.4. When the sky is painted.

•	 Select Background Layer
•	 Select a suitable colour from 

the Foreground Colour 
Selector

(As Background Colour Selector 
already has the colour white, we 
don’t have to select white.)
•	 Select Gradient tool(G) 

from the toolbox
•	 Drag from top to bottom to 

fill the canvas with colour

The icons of some of the  
selection tools in Krita Tool 
Docker is given here.  
Find their names. 

Using Gradient to Paint
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Drawing the Seashore

The seashore (the beach) is to be drawn at the very 
bottom of the canvas. To do that, paint that portion 
after selecting it with the Polygonal Selection Tool. 
See Fig. 4.6.

So painting the seashore is finished. 

Now, using the Gradient tool you have learned 
earlier, join the colours to make it look attractive. 

Fig. 4. 5. When the sky and the sea are drawn

Fig. 4.6. When the seashore is drawn

•	 Select Polygonal Selection 
Tool.

•	 Select only the portion to 
be painted.

•	 Apply colour in the se-
lected portion using Fill a 
Selection Tool.

•	 Use Deselect option after 
right clicking to remove the 
selection.

If you are not  
satisfied with your 
attempt, go back 
using Edit → Undo  
and paint again. 

Drawing the Seashore
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Waves on the Sea

In Fig. 4. 1. We see the sunrays reflected by the 
waves in the sea. Let’s make our waves also more 
beautiful by drawing them in the same way. 

Krita has many brushes and stamp patterns. We can 
use these to make our pictures attractive easily. The 
Texture Brushes in the toolbar will help us in the task. 

Look at fig. 4.8. Using Texture Brushes, make the 
surface of your sea as attractive as in the picture.

Fig. 4.7. Texture Brushes

You have now drawn the 
background. So, let’s save the 

file. After selecting 
File → Save, click on Save

after naming the file. 

Fig. 4.8. When the sea waves are drawn

• Select Freehand brush tool
from the Tool box

• Select stamp water from 
Choose brush preset

• Use Toolbar to adjust the 
length & colour of the brush 

• Click on the seawater to 
draw waves

Drawing the Waves

background. So, let’s save the 

File → Save

Hope you’ll remember 
the Format of the 

picture you’ve saved
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See how easy it is to draw the waves! Similarly, 
you can also draw the clouds in the sky. Use the 
brush, Airbrush Soft to draw the clouds. 

The Grass on the Beach
Look at Fig. 4. 1. once again to find out what else 

is needed to complete your picture. 
    • Grass
    • Lighthouse

First, Let’s draw the grass. 
You know that all the background elements are 

drawn in layers. 
If you draw the other elements of the picture in 

the same background, it will be difficult to erase or 
shift them.  So, let’s draw them in different layers. 

To draw the grass, we can use Paint Layer 1 from 
the Layer Docker. 

Using the Texture Brush, you can easily add the 
grass on the canvas in the same way as you have 
added waves.

Select an appropriate brush from Choose brush 
preset to draw the grass. See Fig. 4.9.

Don’t forget to save your file after you have  
completed each step.

To the left of each layer in the 
Layer Docker, there is an eye 
icon. If you click the eye icon 
on and then activate it, you can 
see the layer. Deactivate it to 
hide the layer.

Hiding the Layers

Fig. 4.9. When the picture was completed

Blender Blur
Use the brush,  
Blender Blur

to merge the colors.
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Drawing the Lighthouse

We have to draw a lighthouse as well. Let’s do 
it in a layer different from Paint Layer 1. How do 
we include a new layer in Krita? On page 44, there 
is a description and a picture of layers. Read the 
description to create a new layer, Paint Layer 2. See 
Fig. 4. 10. 

Generally, lighthouses are towers with angular 
shapes. Draw the outline of the tower to paint it and 
complete the picture. 

It may be a little difficult to draw straight lines 
using brushes. If so, use Bezier Curve tool from the 
toolbox. See Fig. 4. 11.

Drawing the lighthouse is now complete. Now, it 
is to be given colours. 

Let’s Paint

Usually, a lighthouse is painted black, or white or 
red. Sometimes two of these colours are used. Find 
out which tool we need to use to colour the outline 
of our lighthouse. Try the tool, ‘Fill a selection (F)’. 
Hope you’ll appropriately paint your lighthouse in 
this way. 

Grid lines on the canvas 
make it easier to draw.
To get the grid lines, tick 
against the option,
view → show grid on the 
menu bar. 
(Remove the tick mark 
after the use).

Fig. 4.11. Lighthouse included in the figure 

Fig 4.10. After the creation of 
New layer

Grid Lines
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You have completed your picture, haven’t you? 
But, as you can see, the lighthouse is positioned in the 
front. Can we try to push it to the back of the grass? 

Let’s see.

Arranging the Layers

We have drawn our pictures as different layers. 
Do you remember each picture in each of the layers? 

Complete the table below.

The last picture (the lighthouse) seen as positioned 
on the grass. But we need it behind the grass. To do 
that, move Paint Layer 2 to the layer just below it. 
Read the note on layers on page 44 and move Paint 
Layer 2 in the Layer Docker to the layer just below it.  

See, the lighthouse is now behind the grass.

•	 Using Blender blur-
brush, merge the  
colours at the border. 

•	 Using the tools Move 
& Transfer, change the 
position and the size of 
the picture.

Making the Picture 
Attractive

Paint layer 2
Paint Layer 1

Background The seashore background
(the sea, the sky, the beach)

Table 4. 3. The Layers.
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And, let’s not forget to save the file. 

Exporting the Picture

The picture we have now prepared is saved in the 
File format of Krita. Will this file work in mobile 
phones and other systems? 

If you want to use this picture for any other purpose, 
you have to convert it into a general picture-file format. 
The Export option in Krita will help you do this. The 
picture-file format, PNG can be opened by almost all 
computers. So, export it to PNG format and save it. 

• You can export the picture using File → Export in 
the menu bar.

• While exporting, remember to select the file format 
(Here, PNG image) in the window, Files of types. 

We have created a picture using the Krita software. 
Try creating more pictures using the other tools in Krita. 

Krita’s project file format is .kra. This file can 
be opened only in Krita or a software that 
supports the .kra format.

PNG is the short form for 
Portable Network Graphic.
Pictures in this format can be 
used in transparent/ translucent 
background.

PNG Images

Fig. 4. 12. The completed picture

Please dont 
forget to 

save.



INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Colourful Pictures 53

          Assessment              
• Below are given a few selection tools in Krita. Which of these tools is appropriate 

for selecting the required parts from a picture?
  a) Polygonal selection tool  b) Select shapes tool
  c) Move a layer tool   d) Line tool
       

• Which of the following is the project file format of Krita?
  a) kra       b) png     
  c) mp4    d) odt

• Which brush in Krita can be used to merge the colours at the border? 
  a)  Dynamic brush  tool     b)  Freehand brush tool      
  c)  Blender blur  brush  d)  Edit shape tool

       
          Follow-up
1. Draw a ship far away on the sea in the picture you have already drawn.

2. Your picture is now on your computer. What are the steps you need to take to 
get a print of this picture? Please find out.  

          Assessment 

          Follow-up
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Chapter 5

Creating Computer Games

There are too many games in our mobile phones 
and computers. How many of them do you know?

    • Sudoku

    • Chess

    • -------

Who created these games? 

Can we also create such games? 

How are these computer games created?

You know that computers work according to our 
instructions. The method of putting in instructions for 
computers to work is called computer programing. 
It is through computer programing that games and 
applications (apps) are created. 

To give instructions into a computer, we need 
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computer languages. Scratch, which you learned in 
the previous classes, is one such language. Have you 
come across any other computer languages? 

    • Java

    • Python

    • --------- 

In our resource folder, there is a game created 
through Scratch. We may try that game.  

To activate the game,

• Go to School_Resources on Home on your com-
puter and open the folder for Class VII students.  

• Double click on the file, Roadcrossing.sb3 to 
open the game. See Fig. 5.1. 

Computer languages are created to control computers. Java, C++ and 
Ruby are some of them we use today. Usually programs are created by 
typing instructions in the form of texts. Instead of using texts, we can also 
develop using block programing, in which programmes are developed 
with code blocks. Scratch follows on block programing technique. 

Fig. 5. 1. Road Crossing Game – the main window

Computer Language
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Let’s take the Chick Home

In the game,  there is a chick whose home is on 
the other side of the road. There is heavy traffic, and 
the chick has to cross it to reach home. 

The game begins as you click on      . We can use 
the keys, (UP arrow) and (DOWN arrow) to move 
the chick back and forth. Try taking the chick home 
without it  getting into any traffic accident. 

Could you always take the chick safely to the other 
side? What happened to the chick when it crashed into 
a vehicle? Did the game stop at any time?  Repeat the 
game and complete the timeline below. 

Let’s Create a Game

Scratch can be used to create games like the one we 
just played. Shall we create the same Road Crossing 
game using scratch? What do you say? 

When the chick was 
safely taken  
to the otherside   

When the  
vehichle hit  
the chick  

Nothing happened to the chick

...............................

It could reach home

.................................

Game didn’t stop	

Game stopped
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Before we create the game, we must know thor-
oughly each object in the game. We should understand 
exactly every object (element) in the game and how 
they behave at each stage. Complete the table below 
based on the game we just played.

   

      Now, let’s create the game after incorporating 
these objects. 

Creating the Background

As the background, we need the picture with the 
chick’s home (the henhouse). Scratch library has 
many pictures, but not the picture for our background. 
So, let’s take the picture Village.png in the resource 
folder. For this,

click on the stage icon

Select the option, Upload Backdrop 

Objects Working

The picture with the road  • Exists as the background.

The chick

•	 Moves as UP & DOWN when arrow keys 
are pressed

•	 ......................................

•	 .........................................

The vehicle •	 ............................

•	 ............................

Table 5.1. Road Crossing Game - The stage of activity
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•	 Click on village.png in the resource folder to add 
it. See fig. 5.2.

Is there any easy way to locate the picture we want 
from the Backdrop library? Try it. 

The Moving Chick

Who is the main character in the game? Yes, the 
chick. 

How do we move it? Maybe, you remember that 
we moved it by means of the arrow keys.

We can add the chick as a sprite in to the game.Since 
our scratch library has no chick in it, use the one in 
the resource folder. To add the sprite from the folder,

    • Choose the sprite icon

    • Click on the option, Upload sprite

    • Find the School_Resources folder and select 
the picture, chick.png to add it. See Fig. 5.3.

Fig. 5.2. The window with the Background Picture 

Stage and Sprites

Characters used in anima-
tions and games created 
in Scratch are called 
sprites. The stage is the 
background on which 
these sprites are arranged.
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To adjust the size of the sprite, go to sprite prop-
erties  and enter the size you need in the size column. 
See Fig. 5.4. 

Also, please find out what other facilities are there 
in sprite properties to fine-tune the sprite. 

When the vehicle/ the car hits the sprite, it has to 
fall. How do we achieve that? Read the note below.

Fig. 5.3. The window with the sprite

Fig. 5. 4. Sprite properties window
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So, we need another image to change the chick’s 
costume. 

Check the Resource_Folder.

Let’s use the picture, chick1.png in the resource 
folder.

How do we add it? Just follow the steps below to 
include the fallen chick costume (chick1. png). 

    • Select the sprite (the chick)

    • Select the option, upload costume from the 
icon, choose costume in the costume tab. See Fig. 5. 5.

                    Costume

To illustrate the motion, emotion and 
changes in form of a sprite. Scratch has a 
method of providing different images. Those 
images are called costumes. Except for the 
first costume of the sprite, all other costumes 
are taken from the costume tab of that sprite.

Fig. 5. 5. The window to upload the New Costume
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•	 Select chick1.png from the folder and include it. 
We have now two costumes for our sprite, the 
chick. See Fig. 5.6.

•	 When the vehicle hits the chick, you can display 
the second costume in place of the first. 

Moving the Chick

Let’s now consider applying motion to the chick. 
It moves up when the arrow key, ‘UP’ is pressed. 
Let’s write down those steps in order.  

    • Press the arrow key, ‘UP’

    • The chick’s direction is arranged upwards

    • The chick moves up

Click the Do not rotate option in the direction box 
of the sprite properties to prevent the chick from 
rotating when the direction changes. (See Fig. 5.7) 

Fig. 5.6. 
The change after the new costume was applied
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Now, from the appropriate code blocks, find out the 
instructions for moving the chick and arrange them 
in the script area.  See Fig. 5.8. 

Similarly, we can use the arrow key, ‘DOWN’ to 
move the chick down. Hope you’ll find the directions 
for moving it down and try doing so. 

• ----------------------- 

• ----------------------- 

• -----------------------

Fig. 5. 7. Adjusting the direction of the sprite

Fig. 5.8. The directions for moving the sprite

Let’s Save

To save the activities in 
scratch click on the option, 
Save as… in the file menu. 
Type in the window the 
name of the file and click 
the save button. 
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When the game starts, there has to be constant 
traffic on the road. How do we create that?

We can use the image of the vehicle in the resource 
folder as a sprite for this purpose. 

Maybe, you remember that there were different 
vehicles when we played the game. Can we create the 
effect of having many vehicles with a single sprite?  
Actually, we can. We just have to use costumes of 
different types of vehicles as costumes for our vehicle/
car sprite and display them alternatively. Test it by 
using costumes for our car sprite.  At the same time, 
try to adjust the size of the car sprite as well. 

The car is supposed to move from the right of the 
stage to its left. Shall we write down this movement 
step by step?

•	 As we click the , the action starts.

•	  The car arrives at the assigned spot (right of the 
stage).

•	 The car moves to the assigned spot on the left of 
the stage. 

•	  Once it reaches there, its costume changes. 

•	  The movement is repeated. 

•	 To achieve this,  position the car sprite on the 
right of the stage and find the code 

from the motion block; then, move the sprite to the 
extreme left of the stage and find the code 

and arrange the codes appropriately.
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Now, click on this code block. 

What happens? The car moves from the right to 
the left.

This activity has to be repeated from the start of 
the game to its end. Every time we must feel that a 
new car is appearing. What are we supposed to do to 
make that possible? 

Arrange the codes as shown in Fig. 5. 9.

Now, we can click on the  to start the game. 

Later on, you can change the values in the code 
and see the changes that happen. 

Hope you have understood the changes to be made 
in the code to alter the speed of the car sprite. 

When the Car Hits the Chick

Let’s review our activities so far.

• We entered the background picture

• We moved the chick

• The vehicles are on constant move

• The vehicle keeps on changing each time

What else do we need in our game? 

To complete the game, we need to include the 
changes that happen when the car hits the chick. Let’s 
make a list of those changes. 

Fig. 5. 9. The Code for 
moving the vehicles 
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    • The shape of the chick must change

    • The vehicle must stop

    • ---------------------- 

We can add together the code 

in the sensing block and the code 

in the control block to design the instructions to 
recognise the car hitting the chick. 

Now, the instructions for the changes as the car 
hits can be arranged inside the script as given below.

As the car may hit the chick at any time during 
the game, this script is to be repeated throughout the 
game. Hence, we have to add the instruction, forever 
also in the script. At the same time, we also have to 
add the script for moving the chick to its beginning 
position as costume chick 1. See Fig. 5.10.

We have now completed all the elements and 
Fig. 5.10. The code 

for changing the sprite’s  
costume as the car hits. 
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scripts for the game (Fig. 5.10). You can now test 
the game and see what happens. And, don’t forget to 
save the file in your folder. 

New Sprite

If the chick reaches home, we need to show that 
the game is won and that the game is over. We can 
use the picture of a henhouse in the resource folder 
for this purpose. We need to create a new sprite that 
shows the text “YOU WON”, when the chick touches 
the henhouse. Take a look at Fig. 5.11. 

How do we create a new sprite? Draw a new sprite 
with the help of your teacher and expand the scope 
of the game.  

Fig. 5.11.  The window that creates text as a sprite. 

      Assessment

• What do you call the images that lend motion, emotion and change of 
form to a sprite? 

   a. Script     b. Costume

  c. Background   d. Sprite 2

      

Don't forget to 
save the file.
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    • Which of the following is NOT related to the block programing language? 

      a. Instructions are available in the form of code blocks

      b. Programmes can be created by dragging the codes

     c. Instructions are available in text-form

      d. Computer programmes can be created. 

     Follow-up

• We prepared the message “YOU WON” to be displayed when the chick crossed 
the road safely. Now, expand the game by including another sprite that shows 
the message “TRY AGAIN” when the car hits the chick. 

     Follow-up



68

INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Ashwin and Hita are busy preparing the 
Electrical Wiring project for their School Science 
Fest. However much they tried, the bulb in the 
prepared circuit remained unlit. What may be 
the reason for the failure?

    • The circuit is not proper.

    • ------------------------------ 

    • ------------------------------

What do we need to do for the bulb in the 
circuit to be lit? Without physically making a 
circuit, can we create a circuit on our computer 
using the necessary parts to test whether it works? 
If that is possible, we can easily understand the 
making of even complex circuits. 

Chapter 6

Virtual Circuits

Virtual Circuits
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Today, there are many software that help us to 
arrange the parts in a circuit and test its working. 
The D. C. Virtual Lab in our computer’s PhET is 
such a software. 

Making a Circuit In Phet

Let’s open the PhET – Circuit Construction Kit: 
DC – Virtual Lab and create a circuit to virtually 
test its working.  

 Fig. 6.2. shows a circuit with one cell prepared 
in the Circuit Construction Kit: DC - Virtual Lab of 
the PhET software. Please have a look at it. 

Virtual Circuits

Fig. 6.1. A circuit with a cell

PhET – Physical Education Technology

PhET interactive simulations is a non-profit project operating at the 
University of Colorado Boulder. The project is mainly meant for teaching 
and learning. One can access PhET online through the website https:// phet.
colorado.edu/ 
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Could you write down the steps required for mak-
ing this circuit in DC - Virtual Lab?

•	 Find out the required parts of the circuit from the 
Component Box. 

•	 Drag those parts from the Component Box to the 
main window.

•	 Connect the parts in the proper way. 

Once we complete the circuit connections, we 
can see the bulb lighting up. 

Virtual Circuits

Fig. 6.2. A circuit with a cell prepared in circuit construction kit:  
DC- Virtual Lab

Entering the Parts  
in the Circuit Window

•	 Drag the required parts from the Component 
Box to the window

•	 Use the circular connector at the end of each 
parts to connect the parts to each other.
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More Circuits

 Now, as shown in Fig. 6. 3., make a circuit to see 
the bulb light up.

How is this circuit different from the previous one? 

    • The number of cells increased

    • ----------------------------------- 

Controlling the Circuit

In both the circuits we have seen, the bulb always 
remains lighted. If we can include in the circuit a 
device to switch on and switch off the light, the 
circuit will be in our control. See Fig. 6. 4. 

Now, try making the circuits shown Fig. 6.5. and 
Fig. 6.6. in the DC – Virtual Lab

Virtual Circuits

Fig. 6.3. A circuit with two cells 
 prepared in the DC – Virtual Lab

Fig. 6. 4.  
A circuit with a switch
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Now, after writing the steps needed for adding a 
switch in an existing circuit, add it to the first circuit 
we prepared.

• Cut off the connection at a convenient place in 
the circuit

• ..............................................................

• ..............................................................

Hope that you would prepare the various circuits in 
your lessons using the DC – Virtual Lab simulations 
and examine them closely. 

Virtual Circuits

Fig. 6. 5. The circuit in 
switch-off mode

Fig. 6.6. The circuit in 
switch-on mode

Disconnecting the Components

The parts needed to be connected to form a circuit 
in the PhET window are called components. To 
disconnect a part, we just need to click on the icon, 
scissors that appears when we click on the part. 
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Assessment

    • Match the parts and their names given below

    • Which of the following parts is to be used to light the bulb in the given circuit? 

      a. Wire    b. Fuse

  c. Switch    d. Cell

   Follow-up

    1. Make a new circuit adding a fuse in the circuit you previously prepared. 
Then, add more cells and examine the circuit closely. What do you conclude?

    2. Open the PhET → Circuit Construction Kit: DC-Virtual Lab; Create circuits 
as shown in the picture given below; switch on the circuit and watch the intensity 
of the light in the bulb.  

Virtual Circuits

Parts Names

Cell

Switch

Wire

Fuse
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Chapter 7

Making the Presentation Vivid

What you see above is a poster on the Chandrayan 
Mission made by Nandita as part of poster-making 
competition conducted by the Science Club. The 
club’s next main activity is a science seminar on 
India’s Moon Missions. The programme notice has 
announced that the topic-related information and the 
images may be digitally presented. 
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The children’s exploration of making their com-
puter presentation in the seminar excellent, led them 
ultimately to the Presentation Software. They finally 
made up their mind to use the Impress software in 
the school lab. 

Getting Ready for Presentation

Each group in the Science Club was asked to 
present different stages of India’s lunar missions 
in the seminar. Appu’s group was asked to present 
Chandrayan-related activities.  Do you know things to 
be included in a computer presentation of Chandrayan 
Mission?

• Images related to Chandrayan

• Animation video of its landing on the Moon

• Other important matters about Chandrayan

• .....................................................

Appu’s group gathered the images and the videos 
of Chandrayan from the Internet, and important data 
about it from Wikipedia. 

LibreOffice Impress

LibreOffice Impress is a presentation soft-
ware made and maintained by the organization, 
Document Foundation. Impress helps us to present 
texts/images/audios/ videos cutely and clearly. 
There are other presentation software programs 
as well – like Microsoft’s PowerPoint and Apple’s 
Keynote. 



76

INFORMATION & COMMUNICATIONS TECHNOLOGY - VII

Making the Presentation Vivid

The texts, the images and the videos for the pres-
entation are now all ready. The next task is to prepare 
the presentation with the material gathered. How do 
we go about it? Shall we give it a try? 

In a presentation, the data are presented on different 
screens. So, let’s write down in a notebook the data 
for presentation for each screen. That will make it 
easy for us to enter the data into the computer. 

Appu and team wrote down the content for each 
screen in the way given below. 

You know that the content is displayed by means 
of a projector. So it has to be regulated in proportion 

Can we use
 these pictures free?

Check the license  
and see if it can be 

used free.
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to the size of the screen. Images and others should 
be positioned keeping in mind where on the screen 
they have to appear. 

The content to be presented on screen has to be 
modelled in the same way as shown above. Hope 
you have written it down. 

Let’s now open the software, LibreOffice Impress 
in our computer, to prepare the presentation. 

When you Open Impress

If it is LibreOffice Writer, we can start typing the 
content as soon as we open it. But when we open 
Impress, what we get is a window asking us to Select 
a Template. See Fig 7. 1. This window gives us the 

Screen 2

Screen 4

Screen 1

CHANDRAYAN 3 

India’s Moon Mission

SIGNIFICANCE
• Launched on July 14, 2023 by ISRO
• Successful lunar mission after USA,   
  Russia & China
• ......................................................

Screen 3
FEATURES 
 ..........................
 Consists of Prgyan Rover 
   and Vikram Lander
 Sends data to Earth Image of 

Chandrayan

The arrangement of the content for presentation
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design templates which form a part of the Impress 
software. If we want to use any of these readymade 
designs, we can select it to open it. Otherwise, we 
can close the window and proceed. 

Once we close this window, we get the main win-
dow of Impress (Fig. 7.2.). You can see that it is 
different from the Writer window. 

Fig. 7.1. The window that opens when Impress is opened. 

Fig. 7.2 The Impress main window
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What differences do you see between the Writer 
and the Impress?

Write them down.

•	  In the Writer, we can type in the content directly. 
But in the case of Impress it is not possible.

•	 In place of Page in the Writer’s status bar, we 
have Slide in the Impress.  

•	  -------------------------------------------  

Preparing the Slides

Have you noticed the Layouts that appear when 
you open the Impress window (Fig. 7.3)? Such layouts 
are there as part of presentation to make slide-making 
easier. 

Look at Fig. 7.3. What all can be included in a 
slide using the layouts? 

•	 We can include headings

•	  ---------------------------- 

In the presentation 
software, the content is 
arranged in -- . During the 
presentation, the content is 
displayed screen by screen. 

The Impress slides can 
be regulated as per the 
screen size and presented 
in the required order. 

Fig. 7. 3 The Layouts in the Impress 

To add title

To add subtitile

Present layout

Slide
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Can we use the selected layout to include the 
content we have prepared for Screen 1? 

After clicking respectively on Click to Add Title 
and Click to Add Text, can we type in the heading 
Chandrayan 3 and the subheading India’s Moon 
Mission? Try it. 

Now, make the text we entered nice and neat by 
applying proper size and colour to it. To do this, we 
have to make necessary changes in the properties 
window we get (Fig. 7. 4.), when we select the text. 
Make those changes to make the text appealing. 

 Adding New Slides

We have now entered the content for the first slide. 
In the Writer software, we automatically move to 
the next page, once the first page is over. But how 
to add a new slide in Impress? For that, we go to the 
Slide menu, select the required option and add the 
new slide. Please find out the difference between the 

Fig. 7.4. The properties’ window that pops up while selecting the text
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use of the New Slide option and that of the Duplicate 
Slide option to complete Table 7. 1.  Also, find an 
alternative to add new slides after examining Fig. 7.5. 

We can add as many slides as we want in the way 
shown above. Once we have added the slides, we 
have to locate appropriate layouts for their content. 

Now, select the layout, ‘Title, Content’ and include 
the content for Screen 2 in the new slide. See Fig. 7. 6.

What are the advantages when we prepare a slide 
like this? 

•	 We can add the heading separately.

      The font size of the heading -------

Fig. 7.5. The Dropdown Menu 
for adding New Slides

Fig. 7.6. The window for selecting layouts

Table 7.1. Uses of slides

Device         Use

New Slide

Duplicate Slide

Place the mouse 
pointer over the 
layout to see its 

name

Title, Content 
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•	 We can also add content separately

     Font size of the content--------

•	 We can make appropriate changes in the font’s 
size and colour

•	 ----------------------

The table below shows the details of layout Appu 
and his team had suggested for the third screen design 
they prepared. Check whether they are fitting. Also, 
design two more slides and find an appropriate layout 
for them to complete Table 7.2. 

Beautifying with Pictures

As per the design above, in the third slide, we have 
to add the image of Chandrayan along with the listed 
info. We have to find a layout that is appropriate for 
that. Check the layout for Title and 2 content in Table 
7.2. Here we can enter the content in two columns. 
Suppose we enter the basic facts in column 1 and the 
picture in column 2; how will it be? 

We already know that we can type into the box 
after clicking on it, if we want to type in the content. 

Screen Design Selected Layout Fitting Content

Screen 3 Title and 2 content Title and two-column content. Image 
in column1 & text in column 2

Screen 4

Screen 5

Table 7.2. Details of Layout
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However, this box has facility to easily enter pictures. 
See Fig. 7.7

Besides typing, this facility allows us to include 
four types of content. Take the mouse pointer to the 
top of this facility and locate the method to include 
images. Also, find the use of the other methods and 
complete Table 7.3. 

We have now entered the picture. 

Having included the picture in the third slide, we 
now need to design a fourth screen. In the fourth 
screen, we can include a video in the same place 
where we included the picture in the third screen. 
Hope you will write down the steps needed for that. 

• Prepare the screen design of the slide

• Select the required Layout

• Type the title after clicking ..................... box.

• Type in the content text in the space for content. 

• Enter the presentation-related video in the next 
column.

To enter the video, click on the right bottom part 
of the icon   

Fig. 7. 7. The facility to 
enter Image, Video, Table 

and Graph

Table 7.3. 
Details of including content in slides

No Tool Use
1 ......... ............  ............. .......... .

2 to include graphs as content
3 ......... ............  ............. .......... .

4 ......... ............  ............. .......... .
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So far, we have learned the method of preparing 
slides using layouts. We can also make slides using 
the blank slide that is displayed in the beginning of 
the layout section. In such situations, we have to 
include the content in the slide using the Text Box 
tool we learned in the Writer software. If that is the 
case, which are those familiar options in the Writer 
that we can use to include pictures in a blank slide? 

• Insert →Image

• Using Tool Icon 

•  ......................................... 

All the slides we have designed are now ready. 
In the same way, we can add any number of slides. 
Include as many slides as required for presenting 
your data. And, never forget to save your changes 
every time you make a change. 

How Easy is Presentation!

Is it enough to make slides? Don’t we have to 
present them? The presentation software programs 
have facilities for that. They can easily handle any 
number of slides, if you click on the option, Start 
from first slide in the Slide Show menu. See Fig. 7.8. 

We can see now our presentation on full screen. 
To go to the next slide, we can press Enter on the 
keyboard or use the Right Arrow. 

Suppose we want to go back to a previous screen? 
What can we do? Hope you will find a way to do so, 
while working with your presentation. 

Save the file, 
please...

Fig. 7.8. 
The facility to display the 

presentation prepared

• Click on the Insert Image
 icon in the  Content Box 
in the layout.

• With the Dialog Box you 
get, include the picture.

Including the Picture
 in the Slide
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      Assessment

• Which of the following technique in LibreOffice Impress helps to add new slides?

      a. Edit slide    b. Add new slide

      c. New slide    d. Insert slide

• Which tool is to be used to include images and videos in LibreOffice Impress?

      a.    b. 

  c.     d. 

      Follow-up

1. Prepare a presentation in memory of India’s freedom fighters by including the 
pictures and information of them. 

2. Prepare a presentation in LibreOffice Impress, to explain Dr. A. P. J. Abdul 
Kalam’s contribution to India’s space exploration. 

      a.    b. 

  c.     d. 
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Recurring Pictures

Appu’s mother bought a sari – a yellow and red 
sari. The border of the sari had pictures sewn on it. 
It was these pictures that caught Appu’s attention. 

“How is the sari?” Mother asked Appu.

“It is the pictures on its border that I like. They 
are patterns. I have such patterns in my math book 
to learn”

Appu made his stand clear. 

Friends, haven’t you noticed the picture pattern on 
the sari? You may have made such geometric patterns 
in your notebook. And, you have seen many other 
similar patterns. Take a look at the pictures given in 
Fig. 8. 1. 

Recurring Pictures
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Have you ever watched how these patterns are 
drawn? 

These patterns are made when the same shape is 
drawn over and over again. 

You know that recurring activities can easily be 
done by computers. But what you see here is not just 
repetition. You also have to draw geometrical shapes 
and maintain precise mathematical laws. 

How do we draw such pictures on the computer? 

Which software can we use for this purpose?

• GeoGebra

• CaRMetal

•  ----------

• ----------- 

• -----------

Geometric Figures (Patterns) on Computers
We can draw patterns using software programs like Krita and KolourPaint. 

But if we want to create shapes according to strict mathematical rules, we 
need to use software programs like GeoGebra, CaRMetal and Cinderella. 
These programs can be used not only to build geometric forms but also to 
test mathematical rules. We can also use programing languages like Scratch 
and Python to create geometric shapes.   

Recurring Pictures

Fig. 8.1. Geometrical patterns

Rose Window

In Catalonia, Spain there 
is a St. Mary’s Church. The 
picture above is that of a 
window in the church. It is 
well-known over the world 
as the ‘Rose Window’.Take 
a look at the pattern in the 
window.
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Drawing Equilateral Shapes

Open the GeoGebra window and draw a triangle. 
You are already familiar with the tool for drawing 
triangles, aren’t you? 

Find the special features these tools to complete 
Table 8.1. 

Now, try drawing an equilateral triangle using 
Regular Polygon. Before that, write down in order 
the steps for drawing.  

• Select the Regular Polygon tool from the GeoGebra 
window. 

• .................................................................

• .................................................................

Recurring Pictures

Drwaing an Equilateral Triangle

Polygon Tools
We can find the Polygon tools among the 

fifth toolset in GeoGebra. We can use the 
tools, Polygon and Regular Polygon to draw 
Polygons. 

• Select Regular Polygon tool from the fifth toolset in GeoGebra window
• Using the tool draw one side of the polygon.
• In the window that opens, provide the number of vertices for the polygon. 

Tool Name of the Tool Use

Polygon ..........

Regular Polygon It has the facility to suggest the number 
of vertices in an equilateral shape. 

Table 8. 1. Polygon Tools
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Using the same tool, can you draw other equilaterals 
like the square and the equilateral pentagon? 

What changes do we need to make in our action 
plan?

•	 When we use regular polygon to draw a square, we 
have to specify the number of vertices as four (4). 

•	 The number of vertices for an equilateral pentagon 
is -----

•	 The number of vertices for an equilateral hexagon 
is ------- 

•	 -------------------------------------------------------- 

Flexible Pictures

The equilateral polygons we have drawn above are 
drawn separately using Regular Polygon tool. But 
don’t you think it would be nice if we can change a 
polygon’s number of sides or vertices as required, 
after we have drawn an equilateral shape? 

GeoGebra has the facility to control the geometric 
shapes by changing their measurements. The tool for 
this purpose is called Slider. This tool can change the 
number of sides, the length of lines, and the degree 
of angles by means of a sliding scale. 

Let’s see how we can control geometric shapes 
using a slider. 

AI generated image

Recurring Pictures

Fig. 8.3: (a) Equilateral Triangle (b) Square (c) Equilateral Pentagon
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Remote Control

First, Let’s make a slider.

• Select the ‘slider’ tool                        from the 
tenth toolset of GeoGebra window. 

• Click on the canvas. In the window that opens, 
give attribute values as Min: 3 and Max: 10. See 
Fig. 8.3. 

Now draw an equilateral shape based on the slider 
and using the Regular Polygon tool. Observe its differ-
ence from the one we have drawn without the slider. 

When we draw with the slider, we have to provide 
the name of the slider in place of the number of sides. 
See Fig. 8.4. 

Select the ‘slider’ tool                        from the 

 Now put the slider to use. 

What happens to the equilateral shape when we 
change the value of the slider? 

You also try equilaterals with more sides (like 
30,50, 100 and so on).  Can you now confirm the 
difference you have seen earlier? 

Recurring Pictures

Fig. 8.3. The Slider window

Fig. 8.4. The number of Sides

Slider

• The slider controls a 
number (For e.g., the 
radius of a circle). 

• The slider is called 
‘a’. (If we add another 
slider, what will be its 
name? ‘b’? Try adding 
a slider and check.)

• The slider’s minimum 
and maximum values by 
default are -5 and +5. 

• We can change the 
values as we like. 
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Shall we now create the patterns we discussed in 
the beginning? 

The Beauty of Recurrence

Let’s create the pattern of the second picture in 
Fig. 8.1. 

Can you guess the difference between the circles 
in the pattern? 

• ---------------------------------- 

If things are so, let’s draw concentric circles of 
different radii. 

What are the tools we can use?

• Circle Center and Radius

• ------------------------------ 

Now, note down the action plan for pattern creation.

• Make a slider with the minimum value 0 and the 
maximum value 10.

• Draw a circle using the ‘Circle Center and Radius’ 
tool.

• Specify the value for the radii.   

Now put the slider to use. What do you see? 

You see only circles of different radii. 

What can we do to see all the shapes separately? 

It can be realized by using the device called Trace. 

Place the mouse on a circle drawn with the slider 
and click the right button. From the window that 
opens, select Trace On (See Fig. 8. 5.). Now, use the 
slider again. Is the pattern formed? 

Don't forget to 
save the file.

Recurring Pictures
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Try to create more patterns by changing the value 
for the slider. 

Activity Tools to use

To draw a square

To draw a circle that passes through the  
three vertices of a triangle

To draw a circle the radius of which can be 
altered by a slider

To draw a circle with unspecified radius or 
centre.

       Assessment

• When we make a slider in GeoGebra to draw regular polygons, why is the 
minimum value three (3)? 

• Complete the table below after finding the tools for doing the following 
activities in GeoGebra window. 

       

Recurring Pictures

Fig. 8.5. The window providing trace
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Follow -up

    1. Open the GeoGebra software and prepare a picture according to the action 
plan given below. 

• Draw a circle with a radius of 2 units (Tool: Circle Center & Radius)

• Mark a point in the circle (Tool: Point)

• Make an Angle Slider with 00 to 3600 (Tool: Slider- Angle)

• Create an angle that includes the point marked on the circle and the centre of 
the circle. The value of the angle must be the value of the slider. (Tool: Angle 
with given size)

• Draw a circle with the point now made in the circle as the centre and its distance 
to the first point you made as the radius (Tool: Circle with Center through Point)

• Provide ‘Trace On’ to the new circle

• Move the Slider. 

2. Find the name of the pattern obtained by the above activity and its features. 

(Take the help of your teacher to take a screenshot of the pattern and find out 
about it from the Internet through Image Search)

Recurring Pictures
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Computer Vision

Chapter 9

Computer Vision

Surprise! How did the computer know that Ammu 
looks sad? Does it have eyes to see her sadness? 
Which part of it enables it to see things? Is it the 
camera?
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Computer Vision

Do you have a camera in your laptop? Check it. 

What do we usually use the computer (web) camera 
for? 

Of course, we use it for online meetings and video 
calls.

We can also use the web camera for taking photos 
and videos.

It was through the camera, wasn’t it, that Ammu’s 
laptop identified Ammu.  How do computers identify 
things that they see through their camera? 

You may have also read or heard the news of AI 
cameras identifying traffic violators. How do these 
cameras work? Have you ever thought about it? 

Look at Fig. 9.1. Who is hiding in the picture? 

It is a cat, isn’t it? But you didn’t see the whole 
body of the cat, did you? Then, how did you identify 
it as a cat? 

Fig 9. 1. Who is hiding?
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Computer Vision

Suppose we have never seen a cat. Will we be then 
able to identify a cat as cat? 

But we have seen enough cats of various types in 
our surroundings as well as in pictures and videos. And 
our brain, having understood the special properties 
cats share, has stored in its cells the form and features 
of a cat. It is this stored knowledge that helps us to 
identify the hidden cat. 

It is in the same way that we recognize our sur-
roundings and act according to the situation we are in. 
When a new situation arises, we behave in tune with 
our past knowledge. And, through that experience, 
we learn new things. This knowledge, in turn, we 
apply again in a further new situation. 

Suppose the computer acquires this kind of abil-
ity. If so, it will also store its experience/data as 
knowledge. Today we, human beings, can program 
computers to create the kind of intelligence to use 
their acquired knowledge to use in new situations. 
This intelligence that the computer artificially gains 
through programming is called Artificial (or Created) 
Intelligence (AI, for short).

Today AI technology influences every sphere of 
our life. It has grown so much so that it can now not 
only understand but also recreate images, videos, 
audios, human languages and the like.  

Now you know which technology helped the laptop 
to read Ammu’s sadness, don’t you? 

Recognising Facial Expressions

Let’s make a computer program that will help our 
computer to recognize facial expressions in just the 

Artificial 
Intelligence (AI)

The term Artificial 
Intelligence was coined 
in 1956 by an American 
Computer Scientist called 
John MacCarthy.
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Computer Vision

same way as the program that helped Ammu’s laptop 
to detect her sadness.  

Computer programs, as you know, are created 
with the help of programing languages. Write down 
below the programing languages you already know. 

• Scratch

• ----------

• ----------

• ---------- 

• ----------- 

We have already seen in our previous classes how 
programs are written using Scratch. There is a piece 
of software based on Scratch called PictoBlox - an 
improved software programe which enables us to 
make computer programs based on AI.  

Go to your computer and open PictoBlox to see 
its main window (See Fig. 9. 2.)

The software, PictoBlox is almost the same as the 
software, Scratch. It also has sprites and their stage, 
and the code blocks for programing. 

Click on the ‘Add Extension’      icon in the 
PictoBlox window. 

Do you see more facilities in it than in Scratch 
software? 

You can see buttons in the Choose an Extension
window for additional blocks for doing AI activities. 

We are onto making a program that enables us to 
detect human facial expressions, aren’t we? 

Block Programing

Block programing 
is a method of creating 
a computer programe 
using pre-prepared 
codes. In this kind of 
programing, codes are 
given as separate blocks 
which can be dragged and 
placed as required to make 
programmes. 
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Computer Vision

Do we have a button for this activity in the window?

Maybe, you see a button, Face Detection     , do 
you? 

     , do 

Click on that button, and there it is! The required 
code blocks are now there in our code window. These 
are the codes for the programing of Face Detection.  

Do you understand the use of these instructions? 

Examine the code blocks. You can take the help 
of Table 9.1.  

Fig. 9.2. The main window of PictoBlox

Some Facilities in Pictoblox

• It has block programing as in Scratch.

• It has the facility to write programs with 
Python. 

• It has extensions to do activities of AI and 
Robotics. 
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Computer Vision

No Block Use

1 To take to the stage the pic-
ture snapped by the web 
camera 

2 To analyse the picture for 
detecting faces and their 
expressions

3

To get the expression of the 
first face among the detected 
faces.

Table 9.1. Some Code Blocks related to face detection in the PictoBlox

We recognise an object, as you already know, by 
comparing it with our past knowledge. The computer 
also recognises an object in the same way. The only 
difference is that we have to train our computer to 
do so. 

So, let’s see all those phases through which the 
computer has to pass in order to recognise facial 
expressions. Can you make a guess? 

• We have to keep the computer camera on. 

• The picture captured by the camera is to be 
analysed.

• Once the face is detected in the picture, based on 
the previously analysed faces, its expression must 
be recognised. 

• There must be a reaction in accordance with the 
recognised expression.

• The activity has to get repeated.
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Computer Vision

Fig. 9. 3. Some Smiley Icons

. The facial expression detected by the computer 
can be displayed with a smiley in the program we 
are making. 

Costumes for Expressions

Using PictoBlox, we can give different costumes to 
a sprite for detectable expressions. For this purpose, 
we can use the smiley icons in our computer’s folder 
for class VII students. We have to see that we make 
no mistake while labelling the costumes with names 
such as neutral, happy, angry, sad, disgusted,fear 
and suprised.

Code Blocks to detect facial expressions

We can make a programe to detect faces and 
facial expressions using the code blocks in the 
picture. The computer is already trained with 
the help of thousands of different faces and their 
expressions. The code blocks are made by using 
model files obtained while training. With these, 
almost ten faces can be detected at a time. 

The code blocks in PictoBlox can prepare 
programes that can recognise 7 expressions like 
neutral, happy, angry, sad, disgusted, fear and 
surprised.
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Computer Vision

Preparing the Program

We have now added the costumes of smiley icons.  

Now, activate the program that displays smileys 
in keeping with the expressions caught in the camera 
(See Fig. 9. 4.).

Fig. 9.4. The PictoBlox Program to detect expressions
 and the sample output

Have you tried the program? Good! You have now 
shown that you too can prepare a program like the 

Adding new Costumes in PictoBlox

Let’s Save

• Delete the existing sprite and add a new sprite (the 
first costume) through Upload Sprite.

• Select the tab, Costumes

• Select ‘Choose a Costume→Upload Costume’ at the left bottom. 

• Add the other costumes for sprite selected from the computer.

To save your work in PictoBlox, click on the save 
option in File menu, and type in the window the file 
name and click on save. 
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Computer Vision

one that detects facial expressions with AI technology 
after it has analysed the sights caught by the camera. 

      Assessment

• You prepared the computer vision programm that reacts after detecting facial 
expressions. List some situations where computer vision can be used.

    • Face Unlock in mobile phones 

    • ----------------------------------- 

    • -----------------------------------

    • -----------------------------------

       Follow-up

    1. Making changes in the programm you prepared, detect the expressions in 
two faces at the same time and, as shown in the picture below, express them with 
two smileys. 
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Chapter 10

Reading and Recording Stories

Atul and Fida are very busy. They have been 
selected to present a programme on the World 
Meteorological Day for the school radio station. The 
programme is meant to commemorate the eminent 
Indian Meteorologist, Dr Anna Mani. 

What are the things to be planned for this occasion? 

•	 Data about Anna Mani are to be collected

•	 A brief profile of her is to be prepared 

•	 ......................................................

While collecting the details about Anna Mani, 
Atul and Fida were told by their teacher about an 
interesting story about her in the E3 English Language 
Lab. Shall we also listen to that story? 

Reading & Recording Stories
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Listening to the Stories

Why don’t you open the fourth level of the ELL 
with the help of your teacher? As you open, you can 
see a list of ten interesting stories. You can see Anna 
Mani’s story in it. Locate and open it. If you would 
like to listen to the story, click on the button , Play 
Story (3.2). See Fig. 10. 1.

E3  English Language Lab (ELL)

ELL is a software for improving the English language proficiency of stu-
dents. Its content is arranged into four levels with interesting stories to promote 
learning English. The activities for standard VII can be found in the fourth 
level. Any student can access the programme with a username and a password. 
For example, the username as well as the password for the first student of 
class VII will be 7a1. Once the student accesses the software, he or she can 
do all the activities in the ELL. 

Fig. 10. 1. E3 English Language Lab – 
the window for selecting stories

Reading & Recording Stories
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Did you listen to Anna Mani’s story? And, did 
you like it? 

Can you list the special features of storytelling? 

•	 Voice modulation

•	 Appropriate body language 

•	 ......................................................

Just check the activities related to the story of Anna 
Mani in the ELL. In the activity, Make it Correct (3.6), 
you can see a sample of a commemoration note 
similar to one Anu and Fida are going to present. 
Following the instructions, shall we also try this 
activity? 

Completing the Note Of Commemoration

As you click on the button,  Make it Correct (3.6), 
 you can see the first part of the commemoration note 
on Dr Anna Mani. It is also a brief profile of hers. 
What are its special features? 

Fig. 10.2. ELL - The video window of Anna Mani’s story

Reading & Recording Stories
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Recording

Hope the note of commemoration is completed. 
We can now read it to the computer for recording. 
The Language Lab has the facility to record too. 

    • Important facts and events

    • Organisation of ideas

    • -----------------------------

Hope you’ll follow the instructions and complete 
the note of commemoration. 

To do Make it Correct

    • Click on the button,  Make it Correct 

    • Drag and drop the different portions of the note appropriately in the 
window that opens up to complete activity. See Fig. 10.3

    • Click on Finish Attempt when the commemoration note is complete.
Fig. 10.3. The Drag and Drop activity window

Reading & Recording Stories
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Recording the Audio

•	 When you click on , Record your Respect (3.7). a window with add 
submission opens. Click on that to record your audio.

•	 Select the button,  in the Editor window that emerges 

•	 Start recording clicking on Start Recording button in the Record Audio 
window.   Press on the button, Stop Recording, when the recording is 
over. See Fig. 10.4.

 

Fig. 10.4. The Window for Recording

    • To save the recorded portion, click on the button, Save Recording

    • To submit, click on the button, Save Changes in the Editor window 
that appears. See Fig. 10. 5

Fig. 10.5. The Submit Window after Submission

Voice modulation, as you already know, is very 
important while recording. Finish this activity by 
opening the button , Record your Respect (3.7). 

Reading & Recording Stories
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Improving the Recording

Our first attempt at recording may not be perfect. 
But, before submission, we can rerecord our story 
after listening to it. 

Making Changes in the Audio

•	 Play the recorded portion and select Record Again for improving it.

•	 Save after rerecording if there is no further correction

•	 If you want to correct after submission, click on Edit Submission and 
save it after corrections.  (Fig. 10.5)

Find out the remaining activities in Anna Mani’s 
story and complete them with your teacher’s help. 

Story Listening and Letter Writing

You can see that E3 English Language Lab has other 
interesting stories like Anna Mani’s. Ammu’s Puppy 
is one such story. Just listen to that story. Ammu in 
this story is a girl of great imagination, isn’t she? 

Like Ammu, why can’t you imagine that you have 
a pet and, then, write a letter to your friends? There 
are different sorts of letters. What are they? What do 
you call a letter you write to your friends? What is the 
structure of such a letter? Would you write it down?

Reading & Recording Stories
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•  Salutation

• ...............................

• ...............................

In the E3 English Language Lab, along with the 
story, Ammu’s Puppy, there is an activity called ‘Write 
a Letter”. Hope you’ll read the story and complete 
the letter. 

     Assessment

• Which facility should be selected to make corrections after submitting the audio 
recorded in the E3 English Language Lab? 

     a. Record Again     b. Edit Submission

 c. Remove Submission   d. Record Submission

Reading & Recording Stories
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• Some of the things to be noted in voice modulation while recording the audio 
of the commemoration note are given below. Find the odd one out. 

    a. Speaking with feeling to express emotions. 

    b. Speaking at a fast pace

    c. Speaking with pauses wherever necessary

    d. Speaking warmly and in a friendly manner.

     Follow-up

1. Listen to the other stories in E3 English Language Lab. There is this story of 
Rinki who goes to her elder brother’s room in his absences and is surprised to 
find the Magic Block. Do you like that story?  Narrate this story in your own 
style and record your narration. 

2. Do you like the world of wonder under the sea in the story, Dive? Have you 
gone on any such adventure? Write a note on such an experience and upload it 
to the follow-up activity in the story. 

Reading & Recording Stories
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CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national struggle 
for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon to do 
so;

(e) 	to promote harmony and the spirit of common brotherhood amongst all the 
people of India transcending religious, linguistic and regional or sectional 
diversities; to renounce practices derogatory to the dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, lakes, 
rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry and 
reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and collective 
activity so that the nation constantly rises to higher levels of endeavour 
and achievements;

(k) 	who is a parent or guardian to provide opportunities for education to his 
child or,  as the case may be, ward between age of six and fourteen years.

Reading & Recording Stories
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CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in

Reading & Recording Stories


